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CHAPTER ONE
Introduction

The role of the Finance function continues to be delivering sustainable and superior
stakeholder value, but with access to a wider range of levers to make this happen.  As a
result, the role of the CFO today is broader and more complex than ever.  It is now
widely recognized that creating and maintaining efficiencies in operations is table stakes
for the Finance leadership in an organization.  The CFO is not restricted to optimizing
operations like paying the bills, closing the books and producing financial results. Today
they are expected to develop new approaches to managing their organization; producing
business insights on a daily basis, spotting market opportunities, and helping the business
with scenario planning to help react faster.  Ultimately they are involved in predicting
changes in the business environment and driving the business to growth.

Most enterprise-level CFOs will agree that the global business environment is driving
real-time decision making and require a Single Source of Truth as a prerequisite.
Technological innovations are now able to provide the necessary insight, in an accessible
way, to support this requirement.

S/4 HANA and Simple Finance are presented as SAP’s New Generation
technologies, created to support this new CxO’s agenda.  It is clear that adoption of such
a ground breaking innovation requires an organizational transformation and very strong
Executive Sponsorship, both of which are only secured in an organization when there is
a significant business case to be realized by these implementations.. Although covering
key functionalities such as Universal Journal, Appendix Ledger, new Asset Accounting,
and an Accelerated Close, S/4 HANA Finance is above all about creating a simplified
User Experience and access to real-time data.  

Ever since the S/4 HANA announcement in Feb 2015, a number of questions have
been raised by SAP’s existing and prospective customers.  What is the advantage of the
new offerings? When should one adopt the new offerings? Would implementation of S/4
HANA Finance result in losing any of the functions or customizations available in the
legacy applications?  How much time and effort will be required to migrate to S/4
HANA Finance? What are the pre-requisites?  

I will explain all this topics in detail for new implementation perspective. My earlier
book “Getting Started with S/4 HANA Migration and Conversion” covered technical
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book “Getting Started with S/4 HANA Migration and Conversion” covered technical
and functional migration topics of S/4 HANA. So I will not cover migration and
conversion topics in this book. This book provides step by step process to configure S/4
HANA Finance for a new implementation or Greenfield Implementation. I have
addresses key questions raised by many of customers, I interacted during delivery or
solutioning of S/4 HANA Finance system. It also includes user guide exclusively bsed
on Fiori Apps. All screen shot are from demo system which neither belong to any
company or customer. If you need any assistance or information reach out to me on
dee167@outlook.com. 
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CHAPTER TWO
What is SAP HANA and S/4 HANA

The SAP HANA database is developed in C++ and runs on SUSE Linux Enterprise
server. SAP HANA database consists of multiple servers and the most important
component is the Index Server. SAP HANA database consists of Index Server, Name
Server, Statistics Server, Preprocessor Server and XS Engine

SAP S/4 HANA is short for SAP Business Suite 4 SAP HANA, meaning that it is
the fourth version of SAP Business Suite, but designed to run only on SAP HANA
database. In broader aspects below are the three attributes:

a. S/4 HANA is built on SAP HANA. S/4 HANA as the underlying platform with
increased speed, merge of analytical and merged OLTP & OLAP transactional
data and in-memory compression to reduce data footprint. 

b. SAP HANA allows customer to simplify their applications and the underlying
data model leading to higher flexibility & throughput and data footprint reduction.
Applications are real-Time & Simplified and no aggregates or indices anymore.

c. For better experience SAP inbuilt SAP Fiori as the holistic user experience
paradigm delivering cross application user experience. Fiori apps are web-based,
compatible to all devices, role-based and decisive. 

In a nutshell we can say, in addition to ease of implementation without disruption, S/4
HANA benefits include compression, real time analytics, landscape simplification, and
ease of configuration, delivered through a simplified and enhanced end-user interface
based on SAP Fiori.

SAP HANA is now an established platform for SAP, especially for Analytics in the
Systems of differentiation domain, but increasingly in the ERP space and Systems of
Record.

“In Memory” is a technology that:
– Allows processing of massive quantities of real-time data
–  Provides immediate results from analysis and transactions
– Utilizes main memory (RAM) of the system for faster processing
In practices, this means:
Immediate Answers: Calculations, analytical operations executed 1000x to 10,000x

faster. It delivers the real-time enterprise through the most advanced in-memory
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faster. It delivers the real-time enterprise through the most advanced in-memory
technology. SAP HANA provides a foundation on which to build a new generation of
applications, enabling customers to analyze large quantities of data from virtually any
source in real time.

Real-time Access: Data doesn’t move through as many layers, no aggregation and
logic is at data layer not application layer. SAP HANA delivers the real-time enterprise
through the most advanced in-memory technology.

Single Version of the truth: As a result of simpler data model, and no longer a need
to move data to a separate OLAP for Operational reporting with data latency. SAP
HANA can be integrated into a wide range of enterprise environments, allowing it to
handle data from Oracle databases, Microsoft SQL Server and IBM DB2.

Deeper Insight: Analyze massive amounts of data in fractions of a second. Quickly
and easily create ad-hoc views without needing to know the data or query type - allowing
to formulate actions based on deep insights. 

Business Innovation: SAP HANA is an early innovator for in-memory computing.
Its configurability, easy integration and revolutionary capabilities make it flexible
enough for virtually anything business requires.

Simplicity: SAP HANA has fewer layers, simpler landscape and lower cost. It
reduce the data aggregation, indexing, mapping and exchange-transfer-load (ETL)
needed in complex data warehouses and marts. Interesting part of SAP HANA is, it can
be cloud based, a single-location stack removes latency - enabling real-time
collaboration, processing and planning. A highly robust cloud service allows quick
deployment of current and next generation applications, scaled to business needs.

Lower TCO: Reduced requirements for expensive DBA to manage indices, reduced
storage as a result of no indices or aggregates and compression. 
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Figure 1
In the beginning SAP HANA was introduced keeping in view of BI reporting on real

time basis. So most of the client adopted SAP HANA for SAP BI reporting. 
SAP HANA is one of the fastest growing line of business in SAP product history and

is forecast by the industry as a break through solution for in-memory databases. SAP
HANA claims that it accelerates analytics and applications on a single, in-memory
platform as well as combining databases, data processing, and application platform
capabilities. 

SAP HANA is a next-generation business platform which brings together
● Business transactions
● Advanced analytics
● Social media
● Mobile experience
● Collaborative business
● Design connections

The recent announcement of S/4 HANA reinforces the potential for improvements in
the speed, efficiency, agility and simplification of SAP enabled business and IT
processes. This real time processing against latest data opens up the opportunity for
innovation of business processes as a result of ability to eliminate lengthy batch process. 

Now we will discuss, what the options available for the customers. Various options
are largely driven by business transaction complexity, size of business and investment.  

Currently SAP offering S/4 HANA with different option some of the option available
now are on-premise, public or managed and hybrid deployments to give real choice to
customers. As per recent announcement by SAP, SAP will leverage hybrid deployment
of S/4 HANA to the startup companies. It will maximize the S/4 HANA reach to wider
customer with different industries.  

SAP S/4 HANA on-premise edition already offers a business scope that is similar in
terms of coverage, functionality, industries and languages as the current SAP. S/4HANA
also includes the transformational simplifications delivered with SAP Simple Finance as
well as a planned integration with Success Factors Employee Central and Ariba
Network.

SAP S/4 HANA public cloud edition should address specific business scenarios of
lines of business and industries. In terms of coverage functionality, industries and
languages. It has limited scenarios comparing to on-premise edition.

SAP S/4 HANA managed cloud edition should address a similar business scope as
the on-premise edition. From functionality coverage it will cover essential core ERP
scenarios (FICO, materials management, production planning, sales and distribution,
logistics execution, plant maintenance, project system, and PLM plus integration with
Success Factors Employee Central, Ariba and SAP hybris).

The path forward announced by SAP on S/4 HANA so far not very clear. Let’s
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The path forward announced by SAP on S/4 HANA so far not very clear. Let’s

discuss the SAP provided current options, customer should take decision after analysis
of their business and usage of ERP. 

Figure 2
SAP represents a roadmap forward to S/4 and the cloud with a simplistic view. 

• Migration to cloud infrastructure
• Leverage of cloud SaaS apps (SAP and non-SAP)
• Advanced Analytics
• SAP Cloud Platform for application extensions
• Mobility/User Experience
• New Agile delivery methods and approaches

As a SAP customer if you follow evolution of HANA in last few years, in reality the
roadmap is much more complicated. I find below reasons which make map complicated: 

• Deployment roadmap is uncertain as SAP product direction and migration
strategy remains fluid. Now SAP 1709 came up with more clear direction

• Every element of the Enterprise Platform will have different decision points and
timing

• The resulting “on-ramps” and “off-ramps” will result in different hybrid states that
must be carefully designed and managed

• A harder environment to control - rapid change, new skills demand, new sellers
and new buyers 

• Business benefits not always obvious
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Figure 3
Customer need to consider additional adoption points:
● For migrations, customers will need to consider how to handle existing RDMS

license
● The case for change may be made easier if the customer has a clear pain point in

their existing system.  However, in general the business case will need to be
stronger in case of S/4 HANA to drive a migration from an existing database, in
comparison with a greenfield implementation. 

● Customers would need to spend time assessing the business case (including risk)
of adopting the HANA platform versus running the Business Suite on other
platforms, particularly in industries that use a large number of other connected
applications.

When customer accessing their business domains below are the drivers should
consider mentioned in Figure 4
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Figure 4
Once you are choosing to go for S/4 HANA you are also enabling the technology.

Some of the technology enablers are as following:
• S/4 HANA: A highly evolved suite of simple applications running on the HANA

database system.
• HANA Live: Uses the speed and power of in-memory computing in SAP HANA

as a launching pad for real-time operational reporting and analysis through
leveraging predefined tables and data models

• S/4 HANA Finance: Designed to provide strategic value with instant insight
across finance, all via a personalized and simple user experience.

• Lumira: A self-service solution that allows analysts and decision makers to
access, transform, and visualize data

• Fiori: The new user experience for SAP software. It applies modern design
principles and represents a personalized, responsive and simple user experience
across devices and deployment options

• HANA Cloud Platform: SAP,s designated strategic DevOps platform for
extending SAP (and non-SAP) on Premise and Cloud solutions and building new
applications on the SAP HANA Platform.

Now we summarize, S/4 HANA benefits to business and IT: 
Business Value: S/4 HANA creates unique opportunities to reinvent business models

and drive new revenues and profits. Companies can now easily connect to people,
devices, and business networks to deliver new value to their customers on any channel.
Companies can simplify their processes, drive them in real time and change them as
needed to gain new efficiencies. Business users can now get any insight on any data,
anywhere in real-time. It help them in planning, execution, prediction, and simulation –
decisions. 

IT Value: S/4 HANA simplify the landscape and help reduce total cost of ownership
(TCO). Companies can reduce their data footprint and work with larger data sets in one
system to save hardware costs, operational costs, and time. Innovation is also made
simple with an open platform (SAP HANA Cloud Platform) to drive advanced
applications like predicting, recommending, and simulating. 
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CHAPTER THREE
What is S/4 HANA Finance

S/4 HANA Finance has been built rebuilt to help meet the evolving business needs
of finance departments.  It is a broad offering covering “end to end solutions for
Finance” with data architectural changes and a new set of functionalities that were not a
part of the previous SAP Simple Finance.  It fully leverages the latest in-memory and
real-time capabilities of SAP HANA and provides a modern user experience for business
users on almost any device, a simplified data model and on-the-fly reporting.    

SAP S/4 HANA Finance is a comprehensive solution powered by SAP HANA for
the office of the CFO that delivers instant insights with on-the-fly analysis across all
dimensions of financial data simultaneously without system limitations due to the need
for prebuilt aggregates and data marts. It offers an Intuitive User Experience and the
migration to Simple Finance will be Non-disruptive.

The evolution started of HANA begins the year 2011 and still it’s in transformation
stage, figure 8 shows path of HANA evolution:
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Figure 8
The first release of Simple Finance has been available since Q2 2014 as a part of the

Business Suite on HANA and by Q21 2015, the next version 2.0 was released. The latest
version of SAP S/4 HANA Finance is 1709 released in September 2017, its more robust
version comparing to previous version. This version is fully integrated with logistic
innovation released in 1709.  

Universal Journal: This is SAP’s new definition of “single source of truth” with a
new data model that combines Financial Accounting and Managerial Accounting into
one Universal Journal Entry, all represented in one line item table with full detail for all
components. As all data is now provided real-time from this single journal, effort on
period-end reconciliations is expected to reduce.

Ad hoc capabilities: The new Universal Journal allows ad hoc, on-the-fly
computations for converting periodic transactions, such as month-end activities, from
batch to real time, without needing data to be replicated first to other systems like BI.

Reporting is simplified, fast and multi-dimensional, making the “drill-down” reports
almost redundant.

Accelerated Financial Close: The ability to move away from batch to event-based
processing enables a so called soft-close so that period end processes can run on a daily
or weekly basis.  This will allow organizations to get a more real-time view of their
P&L, providing the business with early visibility of emerging trends.  This will facilitate
prompt remedial action where necessary, rather than the need to wait until after month
end.

Integrated Business Planning in S/4 HANA: New, more user-friendly processes
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Integrated Business Planning in S/4 HANA: New, more user-friendly processes
are added to enable planning in Excel with real-time data and the loading of  plans back
to S/4 HANA for reporting (with templates for Cost Center, Internal Order, Project,
Profit Center, Cost of Sales, and P&L planning).

New Asset Accounting: Mandatory replacement for old Asset Accounting
Smart Cash Management: This is an optional replacement for Cash & Liquidity

Management.  It adds bank account management, short-term cash position & liquidity
forecast reports, and real-time liquidity planning, allowing for tighter cash management
(for optimizing working capital).

Smart Financial Reporting: There are further optional replacements for many of
SAP’s traditional “drill-down reports”. The code framework used by the old reports can’t
be accelerated much with HANA.
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CHAPTER FOUR
Chapter 1 - Enterprise Structure

CHAPTER FIVE
Company Code Configuration

A ‘Company’ is an organizational unit in accounting that represents a business
organization according to the requirements of commercial law of the country. We create
company code ZTH (Jay Demo Company) which is located in country Thailand. 

For configuration we use the following path on the SAP application screen:
SAP Menu -> Tools -> AcceleratedSAP -> Customizing -> SPRO -> Edit Project ->

SAP Reference IMG. 
The above path will refer to the IMG node in rest of the book.  

SAP Customizing Implementation Guide -> Enterprise Structure -> Definition ->
Financial accounting -> Define company

Click on New Entries and Update the following required fields: 

Click on Save entry. Now  the company ZTH is created in S/4 HANA.  
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Company Code is the smallest organizational unit of Financial Accounting for which
a complete self-contained set of accounts can be drawn up for purposes of external
reporting. This includes recording of all relevant transactions and generating all
supporting documents required for financial statements.

IMG -> Enterprise Structure -> Definition -> Financial accounting -> Edit, Copy,
Delete, Check Company

Double click on Edit Company Code, below screen will open:
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Click on New Entries and Update the following required fields: 

The company code in SAP can be kept numeric or alpha-numeric. The country where
company code is located and the balance sheet and income statement according to the
law of country. Our example company is located in Thailand so, we have selected the
country as TH (Thailand). Currency is the local reporting currency of the country
therefore we kept THB  (Thai Baht) as currency. 

Click on Address and update the following fields:

Click on Green tick and Save entry. Now  the company code ZTH is created in S/4
HANA.  

Organizational unit in an company which represents a system used for cost
accounting purposes. A controlling area may contain one or more company codes, which
can be operated in different currencies. Note, the company codes within a controlling
area must all use the same operational chart of accounts. 

In this IMG activity, we define our Controlling area by using the following path on
the SAP application screen: 

IMG -> Enterprise Structure -> Definition -> Financial accounting -> Define
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IMG -> Enterprise Structure -> Definition -> Financial accounting -> Define
Controlling Area

Click on New Entries and Update the following required fields: 

The controlling area in SAP can be kept numeric or alpha-numeric. There will be an
assignment control where we need to select option 1 - “Controlling area same as
company Code”. Rest of the fields populated as per the requirement of country company
code. 

 Click on Green tick and Save entry. Now  the controlling area ZTH is created in S/4
HANA.  

The accounting principles authority like US GAAP and IFRS require companies to
publish segment reporting. Segment is a division of company for which a you can create
financial statements for external reporting. Once you define profit centers, you can enter
an associated segment in the master record of a profit center. The segment is derived
from the assigned profit center during posting. 
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In this IMG activity, we define our segments using following path on the SAP
application screen: 

IMG ->  Enterprise Structure -> Definition -> Financial accounting  -> Define
Segment

Click on New Entries and Update the above required fields.  
 an assignment control where we need to select option 1 - “Controlling area same as

company Code”. Rest of the fields populated as per the requirement of country company
code. 

 Click on Save icon to Save entry. 

A profit center is an organizational unit in accounting that reflects a management-
oriented structure of the organization for the purpose of internal control. We can analyze
operating results for profit centers using either the cost-of-sales or the period accounting
approach.Now SAP promotes accounting based approach so we follow these approach
further in the book.

In this IMG activity, we define our profit center which is assigned to the segment
This is a part of master data so you need to create these profit centers in all the systems
manually using following path on the SAP application screen: 

IMG -> Enterprise Structure -> Definition -> Financial accounting -> Define Profit
Center

Update the above required fields. Click on Save icon to Save entry. 
 

Cost Center Accounting are used for controlling purposes within your organization. It
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Cost Center Accounting are used for controlling purposes within your organization. It

enable us to check the profitability of individual functional areas and provide decision-
making data for management. Cost Center Accounting helps to analyze the overhead
costs according to where they were incurred within the organization.

In this IMG activity, we define cost center which is assigned to the segment. This is a
part of master data so we have to create these cost centers in all the systems manually.
Separate set of cost centers will be created for each company codes. The cost center logic
for all company codes will be same. Every Head Office and Regional Office would be
created as a Cost center in SAP. Cost Centers would be derived from the HO and RO as
they would fall under cost head and no revenue will be recognized. Every cost center
needs to be assigned to a ‘profit center’, which will enable automatic determination of
profit center as and when we post to expense account which will necessitate Cost Center
Entry.

The Accounting documents can update the GL accounts balances by Cost Centers,
resulting in the availability of financial statement reports by Cost Center. A Cost Center
is assigned to a Company code. A 10 digit code may be defined to suit the requirement
of easy reporting. First 4 Digits represent Company Code, next 3 digits represents the
Function/Department and last 3 digits will represent Cost center number.

We define Cost center using following path on the SAP application screen: 
IMG -> Enterprise Structure -> Definition -> Financial accounting -> Define Cost

Center (KS01)
Click on New Entries and Update the following required fields:

If you want to take reference of another cost center mention cost center number as
reference else enter cost center and for specific controlling area and Save entry. Now  the
Cost Center created in the controlling area ZTH.

In this step you assign the company codes which you want to include in the group
accounting to a company. We assign company code ZTH to company ZTH in S/4
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accounting to a company. We assign company code ZTH to company ZTH in S/4

HANA using following path on the SAP application screen: 
IMG -> Enterprise Structure > Assignment > Financial accounting > Assign

company code to company

Click on Save.

The assignment of Profit Center to Company code(s) allows the Profit center to be
posted for the specific company code. In this step you assign the profit center to
company codes. We assign profit center 1000, 2000, 9000 and 9999 to company code
ZTH using following path on the SAP application screen: 

IMG -> Enterprise Structure -> Assignment -> Financial accounting -> Assign Profit
Center to company code 

Click on Activate icon to assign.



S 4 HANA Finance - An Implementation Guide

20

CHAPTER SIX
Chapter 2 - Financial Accounting (New)

CHAPTER SEVEN
Financial Accounting Global Settings (New)

You can define and edit field status variants and groups. Also you group several field
status groups together in one field status variant. Assign the field status variants to a
company code in the activity Assign Company Code to Field Status Variants . This
allows to work with the same field status groups in any number of company codes.
Process field status groups can be defined. Define a field status group in the company
code-specific area of each G/L account. The field status group determines which fields
are ready for input, required entry fields and hidden during document entry. Remember,
additional account assignments (i.e. cost centers or orders) are only possible if data can
be entered in the corresponding fields.

Field status variant 0001 is entered for company code ZTH in the standard S/4
HANA. Field status groups are already defined for this variant. The field status group
you enter in the reconciliation accounts affects postings to the related customer or vendor
accounts. You cannot enter a field status group in the customer or vendor accounts. Field
status groups are determined for customer and vendor accounts from their respective
reconciliation accounts, via the G/L account number in their master records. There are
other factors, besides the field status group itself, which have an influence on the field
status. 

 In this IMG activity, we define field status which used at the time of document
entries by using the following path on the SAP application screen: 

There two options to create the field status variant, either create new fields status
variants for each new company codes being rolled out or copy the Standard Field status
variant 0001 to create new field status variant ZTH. The field status variant ZTH can be
attached to all the group company codes.

IMG -> Financial Accounting (New) -> Financial Accounting Global Settings (New)
->Ledgers -> Fields -> Define Field Status Variants



S 4 HANA Finance - An Implementation Guide

21

Click on copy icon and change the status variant from 0001 to ZTH:

Click on copy all to copy all dependent entries:

Click Save icon to save the changes. Now the field status variant ZTH created. 

 In this IMG activity, in this configuration activity, we assign the company codes in
which we want to use identical field status groups, to the same field status variant. Here
we assign company code ZTH to field status variant ZTH by using the following path on
the SAP application screen: 

IMG -> Financial Accounting (New) -> Financial Accounting Global Settings (New)
-> Ledgers -> Fields -> Assign Company Code to Field Status Variants
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Enter field status variant ZTH and click on Save icon to save the entry. 

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Ledgers -> Ledgers -> Define Ledgers for General Ledgers Accounting
(Transaction Code: FINSC_LEDGER). 

In this IMG activity, we define the ledgers which is used in General Ledger
Accounting. The ledgers are based on a totals table. SAP recommends using the
delivered standard totals table FAGLFLEXT and we will use same in the our settings.
We are not using parallel ledger accounting however I will explain the concept so you
can use in future as per requirement of the customer. 

In S/4 HANA Finance, following types of ledgers are available:
Leading Ledger
The leading ledgers is based on the same accounting principle as that of the

consolidated financial statement. It is integrated with all subsidiary ledgers and is
updated in all the company codes. We must designate one ledgers as the leading ledger.
In each company code, the leading ledger automatically receives the settings that apply
to that company code: the currencies, the fiscal year variant, and the variant of the
posting periods.

Non-Leading Ledger
The non-leading ledgers are parallel ledgers to the leading ledger. They can be based

for example on local accounting principles We must activate a non-leading ledger by
company code as required. For each ledger that we create, a ledger group of the same
name is automatically created.

0L Ledgers is being defined as the Leading Ledgers. This Ledger would represent the
accounting as per IFRS. If a parallel (non-leading) ledgers is being defined for Local
Gaap 

Code Description
0L IFRS Ledger 
IF Local Gaap
Every accounting document will get posted to both the Ledgers simultaneously. As

and when required, additional entries can be made to the Local Gaap ledger to suit the
relevant reporting requirements. SAP standard reports have to be executed for a single
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relevant reporting requirements. SAP standard reports have to be executed for a single
Ledger at a time.

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) ->  Ledgers -> Ledgers -> Define Ledger Group

A ledger group is a combination of ledgers which applies the functions and processes
of general ledger accounting to the group as a whole. A restriction can be set up to update
of individual postings to a ledger group so that the system only posts to the ledgers in
that group. Remember a ledger group does not have to contain more than one ledger
therefore, create ledger groups and assign ledgers to them. 

Enter ledger group which need to include and click on Save icon to save the entry. 

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Ledgers -> Fiscal Year and Posting Periods -> Maintain Fiscal Year Variant
(Maintain Shortened Fisc. Year)

Fiscal Year Variant controls the Beginning and End of Financial Year. Apart from it
controls special posting periods allowed for posting after the normal posting periods
(1-12).

These are the below options available in the S/4 HANA system:
1. Fiscal year is the calendar year - If this applies in your scenario, you must only

select the Calendar year field.
2. Fiscal year is not the same as the calendar year and is not year dependent - In this

scenario, you first enter the number of posting periods in the Number posting per. field.
To define posting periods, select fiscal year variant and select Periods on the navigation
screen. On this screen, enter the month and the day of the period end and the period in
each case.

3. Fiscal year is not the same as the calendar year and is year-dependent - In this
scenario, enter the number of posting periods in the field Number posting periods and
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scenario, enter the number of posting periods in the field Number posting periods and
select the field Year-dependent. To define posting periods, select fiscal year variant and
select Periods on the navigation screen. The system asks for which calendar year your
year-dependent fiscal year variant is valid. Now enter the month and day of the period
end for each of your periods and the periods themselves.

Use SAP standard fiscal year variant as far as possible. Fiscal year variant K4 used
for the financial accounting year corresponds to January to December In case the
financial accounting year is April to March use variant V3. In our example, we will use
standard Fiscal Year Variant K4 the Non-Leading Ledger and the Company Code.

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Ledgers -> Fiscal Year and Posting Periods -> Assign Company Code to a
Fiscal Year Variant

The company code ZTH need to assigned to a fiscal year variant. This assignment
controls which periods the company code will post data. 
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Assign company code ZTH to K4 fiscal variant in the S/4 HANA. Click Save icon
to save the entry. Now company code ZTH is assigned to fiscal variant K4 in S/4
HANA. 

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Ledgers -> Fiscal Year and Posting Periods -> Posting Periods -> Define
Variants for Open Posting Periods

We can define variants for open posting periods in this activity. In the standard
setting, a separate variant for posting periods is defined for every company code. To
make it easy, the name of this variant is identical to the company. In our case, we will
create ZTH posting period variant same as company code. 

Click on 'New Entries" and update the following fields:

Click on Save icon to save entry. Now posting period variant ZTH is created. 

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Ledgers -> Fiscal Year and Posting Periods -> Posting Periods -> Assign
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(New) -> Ledgers -> Fiscal Year and Posting Periods -> Posting Periods -> Assign
Variants to Company Code

The posting period variant ZTH needs to be assigned to company code ZTH.
Therefore assign ZTH to company code ZTH.

Click on Save icon to save entry. Now posting period variant ZTH is assigned to
company code ZTH in S/4 HANA. 

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Ledgers -> Fiscal Year and Posting Periods -> Posting Periods -> Open and
Close Posting Periods

In this configuration step we define the activity specify for each variant which
posting periods are open for posting in SAP. SAP provided with three period intervals 1
to 3. Each interval has a lower period limit, an upper period limit and the fiscal year. We
can specify separate G/L account number ranges as well as sub ledger accounts. To
define we should specify the sub-ledger account type, such as D or K and the
corresponding reconciliation account. By this assignment we can close postings for
customer accounts but allow postings for vendors and GL accounts.

Period intervals 1 and 2 are used for all normal posting processes in regular and
special periods. In S/4 HANA Finance, an option provided in the period interval 1, you
can open posting periods for specif users based on authorization. It can be managed
using user based authorization settings for posting periods (F_BKPF_BUP). In S/4
HANA Finance, posting period variant table will not be locked when multiple users are
using it.

Period interval 3 is used for postings from Controlling (CO) to Financial Accounting
(FI). If an entry made for period interval 3 then the check on these postings made against
period interval 3 only. However, if no entry made for period interval 3, the check on
these postings is made from the real-time integration against period intervals 1 and 2.

Based on my experience, copy the settings from existing company codes delivered by
SAP as follows:
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Click in “maintain All”, next screen appear as below. Select the entries as shown
below:

Click the copy button in above screen and replace all 0001 with ZTH.

Press Enter then click on Save icon to save entry. Now posting periods time intervals
for various account types are created for variant ZTH in SAP. These account types
relates as following in SAP however, create a minimum entry with account type + for all
posting periods which needs to be open.:

A – Assets
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D – Debtors
K - Creditors
M – Material
S - GL

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Global Parameters for Company Code -> Enter Global Parameters

In this configuration activity, we can make various global specifications for the
company code. In addition, we can look at the most important specifications of the
company code at any time in the overview. This includes, among other things, the chart
of accounts and the fiscal year variant. Company code needs to be created for all legal
entities to enable recording of all financial transaction at the level and produce a legal
balance sheet. Company Code Global Parameters determine certain critical assignments
that control basic operations and transaction processing, like Fiscal Year, Posting Period
Variants etc. We nned to make following settings in company codes: 
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Click on Additional Data tab to enter Country related tax information. 

Click on back button and click on Save icon to save the entry. Now global parameters
for company ZTH set. 

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Global Parameters for Company Code -> Set Company Code to Productive

In this configuration activity, we set the productive indicator for the company codes
for which the test phase has been completed. The productive indicator prevents data
within the company code from being deleted by the programs for deleting test data.
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Select your company code as productive once all the cut over activities are
completed. 

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Document -> Document Types -> Define Document Types for Entry View

For each transaction posted in SAP a document is created with a unique document
number. For documents posting in FI, Document Types are defined to distinguish the
transactions and exercise control over the type of accounts that can be dealt with in the
document posting and default certain settings like exchange rate types, batch input etc.
Document numbers are chosen from this number range. We can use one number range
for several document types.

Existing SAP Standard document types can be used. Ensure that the number ranges
are correctly assigned to the respective document types. Existing SAP Standard
document types can be used. The only thing to ensure is that the number ranges are
correctly assigned to the document types. By segregating the ledger-related postings (e.g.
the leading ledger) in a separate number range, we need to ensure the contiguous
assignment of document numbers at the ledger level for each number range.
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 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Document -> Document Types -> Define Document Types for Entry View in a
Ledgers

In this IMG activity, we are defining document types for non-leading ledgers for the
documents in the General Ledgers view. We also assign number range for each document
type which applied in the assignment of document numbers. Some of the points to
consider:

1. No need to make these settings for your leading ledgers because, in the case of this
ledgers, the document number in the entry view always corresponds to the document
number in the general ledgers view.

2. Make these settings for any non-leading ledgers that have a fiscal year variant that
differs in at least one company code from the fiscal year variant of the leading ledgers in
company code. In this case, the document number in the entry view does not correspond
to the document number in the general ledgers view and you need to define a separate
document type with document number assignment for the general ledgers view.

I recommend to take requirement in the below format before configuration:



S 4 HANA Finance - An Implementation Guide

33

Once you take the requirement, configure as below:

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Document -> Document Number Ranges -> Define Document Number
Ranges for Entry View (OBH2)

 
In this IMG activity we creates number ranges for documents. S/4 HANA allows to

assign one or more document types to each number range. The number range becomes
effective via the document type specified in document entry and posting.One number
range can be assigned to several document types meaning we can differentiate documents
by document type but combine them again for filing the original documents, provided
you store your original documents under the EDP document number.
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Number ranges for documents are company code-dependent. Therefore number
ranges for each company code created in which the document type is used, namely with
the same number range key. The number intervals must not overlap. 

You need to manually create transport request for number ranges to transport to next
landscape e.g. DEV to QAS. Follow below path to transport number range objects:

Choose Interval -> Transport in the accounting document Number Range screen.
After the import, only the intervals you export are present. The number statuses are

imported with their values at the time of export. Dependent tables are not transported or
converted.

I recommend to copy the standard number ranges and make it to your customer
specific.  

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New) -> Document -> Document Number Ranges -> Documents in Entry View ->
Copy to Fiscal Year (FAGL_OBH2)

This Tcode is used for Copying Document Number from one year to another. It is
required at year  end activity.

In above activity we determine which intervals of document number ranges are to be
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In above activity we determine which intervals of document number ranges are to be
copied from one fiscal year into another company code. Below input required to copy the
number range: 

1. Company code(s) within which you copy
2. Number range number(s) which are copied
3. Fiscal year from which you copy (source fiscal year)
4. Fiscal year into which you copy (target fiscal year)

Enter the above information as per the company requirement and click on Save icon
to save the entry.

 IMG -> Financial Accounting (New) -> Financial Accounting Global Settings
(New)  -> Document  -> Tolerance Groups Define -> Tolerance Groups for Employees

Tolerance Group for employees determines the values that an employee (SAP User)
is permitted to post per document or per line item. This setting also controls permitted
adjustments like cash discount or small differences in absolute or percentage terms.

As most processes in SAP have their in-built checks and balances through system and
configured controls more importantly in the areas of Invoice Verification and material
receipts, issues etc, no individual controls at document posting levels are deemed
necessary. 

A generic Tolerance group with following parameters is designed for assignment to
all employees. As the Group created is Blank – ‘    ‘, no specific assignments to any
employees is required.
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You can also do the set up following option using this configuration step. You can
predefine various amount limits for your employees with which you determine:

1. The maximum document amount the employee is authorized to post
2. The maximum amount the employee can enter as a line item in a customer or

vendor account
3. The maximum cash discount percentage the employee can grant in a line item
4. The maximum acceptable tolerance for payment differences for the employee.
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Enter the tolerance as per the company requirement and click on Save icon to save
the entry.

 IMG -> Financial Accounting (New)  -> Financial Accounting Global Settings
(New) -> Tools -> Validation/Substitution -> Validation in Accounting Documents
(OB28)

In this configuration activity, you can define additional checks for accounting
documents in the form of validations for each of the company codes. You can assign a
validation for the document header, for the line items and also for Complete document to
each company code. The assigned validations are valid both for manual entry of
documents as well as for the automatic creation of documents.

For every company code to which you want to assign a validation, you store the
following information:

1. Validation callup point - enter key "1" for "Check document header" and key "2"
for "Check line item".

2. Validation - Names of validations which already exist which can display or change.
A new validation must create first which appears in the overview. 

3. Activation level - Enter key "0" for inactive, key "1" for active and key "2" for
active except for batch input.
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Enter above information and click on Save icon to save the entry.

To create new validation, do the following configuration activities:
1. Place the cursor on a line in which company code and validation to be created

(company code and validation set up via Edit -> New entries).
2. Afterward select Environment -> Validation. You reach the first screen to maintain

a validation.
3. Select Validation -> Create. Enter the required name. After pressing ENTER, you

come to an overview screen of the validation activities belonging to the validation.
4. Select Insert entry. On the next screen you can describe a new validation activity.

You describe the check requirements and the actual check for this. 

Enter above information and click on Save icon to save the entry.

 IMG -> Financial Accounting (New)  -> Financial Accounting Global Settings
(New) -> Tools -> Validation/Substitution -> Substitution in Accounting Documents
(OBBH)

In this configuration activity, you define possible changes regarding your accounting
documents in the form of substitutions of individual fields for your company codes. You
can make changes both in the document header and in the line item. The substitutions are
valid for both the manual entry of documents and for the automatic creation of
documents. 

For each company code to which you want to assign a substitution, define the
following information:

1. Time of substitution - Enter the key "1" for substitution within the document
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1. Time of substitution - Enter the key "1" for substitution within the document
header, the key "2" for substitution within the line item and the key "3" for the whole
document.

2. Substitution - Change or display the names of substitutions which already exist. If
you want to create a new substitution follow the step mentioned below. 

3. Activation level - Enter the key "0" for inactive, the key "1" for active and the key
"2" for active.

Enter above information and click on Save icon to save the entry.

To create new validation, do the following configuration activities:
1. Place the cursor on a line in which company code and validation to be created

(company code and validation set up via Edit -> New entries).
2. Afterward select Environment -> Validation. You reach the first screen to maintain

a validation.
3. Select Validation -> Create. Enter the required name. After pressing ENTER, you

come to an overview screen of the validation activities belonging to the validation.
4. Select Insert entry. On the next screen you can describe a new validation activity.

You describe the check requirements and the actual check for this. 

Enter above information and click on Save icon to save the entry.

CHAPTER EIGHT
TAX ON SALES/PURCHASES SETTINGS
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CHAPTER NINE
EXTENDED WITHHOLDING TAX SETTINGS
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CHAPTER TEN
Chapter 3 - GENERAL LEDGER ACCOUNTING (NEW)

CHAPTER ELEVEN
GL PLANNING

CHAPTER TWELVE
FOREIGN CURRENCY VALUATION

CHAPTER THIRTEEN
DEFINE ACCOUNTS FOR MATERIALS MANAGEMENT

(OBYC)
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CHAPTER FOURTEEN
Chapter 4 - ACCOUNTS RECEIVABLES AND ACCOUNTS

PAYABLE

CHAPTER FIFTEEN
AR AND AP CONFIGURATION

CHAPTER SIXTEEN
BANK ACCOUNTING
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CHAPTER SEVENTEEN
Chapter 5 - ASSET ACCOUNTING

CHAPTER EIGHTEEN
ASSET ACCOUNTING CONFIGURATION



S 4 HANA Finance - An Implementation Guide

44

CHAPTER NINETEEN
Chapter 6- Other Configuration

CHAPTER TWENTY
LIQUIDITY FORECAST

CHAPTER TWENTY-ONE
DEFINE ASSESSMENT – ACTUAL

CHAPTER TWENTY-TWO
INTERNAL ORDERS
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CHAPTER TWENTY-THREE
Fiori Configuration

CHAPTER TWENTY-FOUR
App-Specific Configuration for Fiori Apps

CHAPTER TWENTY-FIVE
Additional App-Specific Configuration

CHAPTER TWENTY-SIX
SAP Fiori Launchpad
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